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ABSTRACT

This project presents tracking unmanned drone which the tracking unmanned
drone. Autopilot is the console to study and design unmanned drone. It is tracked a
target by using the phone acts as a transmitter. The-mebile phone locates the target.

It sends location information to the unmanned drone.
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——— S T —
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L N . < ) = o
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ANWTIUNADINTTUNRDATUUTURIAIRINY Y898INIFETY FagUR 2.3
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Meusurd
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Neyw Extamnal 12C part ot Sl O hoard Mag gt
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) 1 9 )
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JUT 2.4 GPS
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M3 2.1 Motor for Multi Copter

Motor for'Multi Copter
Model Type Lipo RPM/V Propeller
2213 355 ARNHR35 1045 i
. 2213 485 T 935 8045
2215 LS 1020 1045
(R215 45 1020 78045
w2218 35 950 ~ 1145/
2218 4s 950 il 9045

Hiuiti copter motor MT2213-038KY (1045Combo)

UMl 2.6 Moter 3u EMAX MT2213-935KV

2.1.6 #Unpaulnsa (Speed Control) MldlunismivauAUEIvBBINs 9N
¢ as A i g ‘H’ 1 v ar a
mIsNNTvMadeuvasuaLifiurinavedlunasly lngastiundyoamunddediiui
¢ . 1w 3 a o =
uasA ArduPilot ATMEGA2560 uaguisanulwidesnnuunees segun 2.7

g‘dﬁl 2.7 Speed Control
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2.1.8 Telemetry Bou1aNAUD 433 MHz wag 915 MHz A1§9de 100mw I
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W | o VM v ) ° o = o P
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i Complete Installation %

pRAt SN

e S5

You can import your settings from a previous version of Android Studio.

1 i want to import my settings from a custom locatiort

Specify config folder or installation home of the previous version of Android Studio:

10! I donothave a previous version of Android Studio or I do not want to import my settings

w1 Complete installation

—
sUn 2.10
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y ¢ New Project.., [}J

Import Project :
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Ipaddeg: ' pos
Foregroundscaling:  (® Crop () Center

NEW Shape: ® Hone (Square () Crde j J

HOPL
N [
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fsuaan Default THas Fa 2 dadandu xmL layout(activity main.xml) Waz Java

(MainActivity java) fsgUfl 2.16

T 5
Amh;ﬂm Hmmun{ e ™
i Layout Name - [actity_main
B R
Descripbion - e -
1h=mw<nfhcncmrydncshume
H
!
} |
[erevios | [ g} cancat | [ ek, |

‘Uﬁ 216 NMsnavun@ Default
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Building 'myAppAndroid' Gradle praojectinfo

o v 2/ § V
JUT 2.17 mienesenasad ™ Project
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s Tip of the Day ; TRy IRE R A ! [EES|

EE Did you know ... 7

wWelcome to Android Studio 0.2.0

Yaou can quickly get familiar with the main features of the IDE by reading
these tips. You may try out the features described in the tips while this
dialog stays open on the screen. If you close the dialog, you can always get
back to it from the Healp | T of the Day main menu item.

[] Show Tips on Startup

| previewsmo || Hextre ] || Close

5U7 2.18 Dialog ¥0¢ Tip
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s% o Wr}. celie

- Open r&w-um-
r;\faqr"bmn file(s) oo %

spen =

l;!mu‘-; u;q%b-dout!'ﬁuﬂuqu}

'5‘LJ'V1 27 19 Mmmmsn’[.uﬂm‘sum Project

lae Path Uo3 XML Layout %EJEJ'Lu /src/res/layout/ ﬁdg‘dﬁ 2.20

{27 valies

57 values swédadp
(57 valesv 11
][] vakes-a14
i AndeodManifest.n
[8) i fauncrerweb.prg
1 buid.grade
Il myandredapamyAndrodasp.inl
2 buld.gradie
[ graden
1 gradew.bat

FR S

41 Build Varants

Favortes

W [Eventiog

'J £ TaeRon
r &

' L el Lu;u« {5 ‘(t-wm, mAqw- tk < i

B _Frometayait

i L!memﬂ‘bmn".‘
 [Uinearlayout Verbeal) 1 ¢
Tadelaycut ) & myAndroidApp

[ iGraayout
| [lreameayolt
Toiwigets
1A PAS Texttiewn
A Large Text
A5 Medium Text
i) Smal Text
Buttan
Smal Buticn
| & Radebuten

|~ ProgressBar {Large)
«m Progresear (ormal)

| == Progressbar (Small}
= Progressar (torzonta)
s SeekByr

Design  Text |

SUT 2.20 Path 489 XML Layout

%‘ | Layouts G‘Biﬂ 4 ‘.1. e




i 1ol > Y i
d7U Java 9w0YN /res/java/ Ngun 2.21

BiProect o]
= [ myAndroidApp (O ns
1 idea
& [ gradle
$ "% myAndroidapp [myAndroidApp-myAndro
| @ [buld

@ [L1lbs
= A e 11

E i main

I & {T1java
Pl =[5 com.example.my oidapp

ot S/ 4 MainActivity
| B Fires
! W [ drawable-hdpi
| @ [£1 drawable-mdpi
> @[] drawable-shopi
| ¥ @[] drawable-xxhdpi
= B layout
i 63/ activity_main,xml
‘ ! (4 1 menu
[ e [ values
& [ values-sw600dp
j [ values-sw720dp-and
' # - [5] values-v11
LB [E)values-w14

B

=l | - 6 AndroidManifest. xml
i ’ ! [d] ic_launcher-web.png
} (E' build.gradle

l }I myAndroidApp-myAndroidApp.iml

'iﬂw 221 Enu*um Java
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TP = A‘l nl o o - v
ASINAMIIRAIY Screen XML Activity Layout wiauiidmiunsilio App s
vagevain Widgets 81 TextView e slagut 2.22

e nakEa

Tﬁm ':;]
E_il' = IIl

oy oL
DLhearLavouto-lwmu} " I TN
I__iLhearLavout {Vertical)
[ Tabletayout
EﬁITabldlvw
E'Gfidi.ayout
[FRelativeLayout

m Widgets Huw Test
A5 Plain Textview /

|AbiLacge Text

o+ Small Button
(@) RadioButton

[+7] ChedkBox

- Switch

| ToggleBution

/& ImageButton
Imageview

== Progressar (Large)

w= ProgressBar (Normal)
e Progressgar (Smal)

= ProgressBar (Horizontal)
s SeekBar

| Design _Text |

gﬂﬁ 2.22 Screen XML Activity Layout
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11 Android Studio @nnsafmuaruasdRves Widgets usiazineld Properties
= @ ) . X W P
Faildnwaeiu Visual Studio fagui 2.23

- iié-Mm;‘- ”:‘.- llj,;A.ppThm EHMam:ﬁvity- Ig‘}v } Component Tree
f117~ © O Device Screen

&[] RelativeLayout
FES P PO 0 T et i 2
E 7 > I S i [Ab] texctView2 - Eating hiella_varl
: IEI;! textView - Tiaw Tevt”

= 3

fed] |
e

® myAndroidApp

Welighrodt

phonetumber ]
adowColor
singleLims 7

text New Text

textAlignment
textAppearance
textColor
textColorHighlight
textColorHint
ootk

wily Text Azlitonmuaninaopnyaminge Activity Aasuil 2.24

® myAndroidApp

Tharreate. Cam

UM 2.24 18ANULARIHADENTINNTAD Activity
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N155U Project vl Emulator TulsnIzdosas1e AVD e Emulator Ined3sn1sasi

o &
JU
\fenLuy Tools -> Android -> AVD Manager fl43uf 2.25
Brelcl VYOS Window  Help
Tasks & Contexts » I
Save File as Template. .. r
Generate JavaDoc... :
Save Project as Template... -
Manage Project Templates... N
XML Actions AN
G' Groovy Shell.,. - ]
fﬁr & SyncProject with Gradle Files
231 Google Cloud Endpoints b ¥t Monitor {DDMS included) :
" | I AvD Manager
i3 SDKManager
v/ Enable ADB Integration
& o 3
$UN 2.25 Tumpun1sdIIe AVD
moUills il AVD wse Emulator Lidmsusulusunsu iden New Juunlual d
=
UM 2.26

y

g Android Virtual Device Manaée;

Tools

* Android Virtual Devices | Device Definitions |

List of existing Android Virtual Devices located at C:\Users\WEERACHAN.android\avd

- Mo AVD available & oo

AVD Name Target Name Platform API Level CPU/ABI New...

Refresh ]

' Avalid Android Virtual Device. ©-| A repairable Android Virtual Device.
>4 An Android Virtual Device that failed to load. Click 'Details' to see the error.

gﬂﬁ 2.26 Android Virtual Device Manager
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o = v v ! . o v o <
fimualie AVD %38 Emulator wiauiuideniuras Device Adoan1siaguil 2.27

Create. newAndroid”V.'lt.tlf;lI.Dwi:e (AVD) it &
AVD Name: AVD_Galaxy|
Device: [Galay Nexus (465", 720 = 1260: xhdpi) -|
Target: | Android 4.2.2 - API Level 17 -|
CPU/ABL | ARM {armeabi-v7a)
Keyboard: fg') Hardware keyboard present

| Skin: ¥l Display a skin with hardware controls

! Front Camera: [Nune vl
Back Camera: !Nun: VI
B L Vo r— Ty

Internal Storage: 200

SD Card:
B Size:
¥ Filer |
!
Emulation Options: [ 71 Snapshot [1Use Host GPU i

TU‘;emue!he e h(g AVD fvith the same name

| & On Windows, =n1u|at|ng RAMgreaterthan?ﬁSMmayhll deperiding {
Try progressively smaller values of RAM if the emulater fails to launch

rﬁﬁ.okw H Cancel l :

U‘i?'i 2.27 ASNINLA AVD

| o 1o v ow 2
mautisli AVD SusniBeuioends (unsdliidoansiud q Aldvanmaats
i) amiuliiden Start, diguil 228

[ F1 Android Virtual I&)evicé"'l“u'lanégerj

Tools

Android Virtual Devices D:v“;e Deﬁmtl ons.

List of existing Android Virtual Devices located at Ci\Users\WEERACHAR . android\avd

AVD Name Target Name Platform API Level CPU/ABI
(ADGlny  Androidd22 422 1 ARM(amesb.. |

Start...

Refresh

R S e e N e S S

" Avalid Android Virtual Device. | | A repairable Android Virtual Device,
¢ An Android Virtual Device that failed to load. Click 'Details' to see the error.

13

5U 2.28 wihsemsidengu AVD
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599¥A3 Emulator avvinu Faazlivinenagui 2.29

O $hsavci R " T b

Qe ('..\.;;;1.-

5 ,, T\:
Uit 2.29 wrhaelnsdinvivassa Emulator

NN33U Project nANEINsaU3N Emulator Linau wiaaz@nlusunsusen
4" s e =Y Y =l s I o [4 o
Tuunealuwlan ey Inglididuazsasma Start 1o wuy Manual

NAUNIN Project Tyiion Run Magui 2.30

i i mfmﬁrﬁf&ﬁp:;amﬂndrbi&@ 4 l i

gﬂﬁ 2.30 A13 Run Project

& & - = " : Do o
Tunauilazilunisiden Emulator filsnadiedu faguil 231
) ChooseDevice. L e ¥ Lﬁ
(®) Choose a running device
Device | serialtumber | state |cComp..|
[£5 Emulator AVD_Galaoxy Androd 4.2, 2 (AP1 17)|emlator-5554 Onine  fyes |
!
|
i
]
|
) Launch emulator i
o=

JUA 2.31 meiden Emulator



| 1% ) @ . a <
sovzA3arlsiNadwsnssu Project Ui AVD Emulator Aaguf 2.32

) IBAAVD Gainey | il e

1_‘ I myAndroidApp

{
| Hello wearid!

ThaCreate. Com

JUR 232 Hadwsnsiu Project Ui AVD Ernutator

17

ad v oA a 3 ' °
TunsfineaInds AVD JudY 5 ¥3e Update ¢ Plugin Twal 9 151815150vn1915en

o 4w b (2
SDK Manager \Wan539d@0uil APl ML51R89013 mgﬂw 2.33

Lﬁaﬂﬁl,m‘g Tools -> Android -» SDK Manager

VCS Aindow  Help
Tasks & Contexts »

Save File as Template. ..
Generate JavaDoc...

Save Project as Template. ..
Manage Project Templates. .,

XML Actions s e
G Groovy Shell... ]
‘?;‘ Android : Foliy ,?, Sync Project with Gradle Files
4% Google Cloud Endpoints » 17 Monitor (DDMS included)
| itl; AVD Manager
S 8 SDK Manager
%/ Enable ADB Integration

2
as

5Ui 2.33 Fumeunslugnindeniu AVD



{dann1s Update # SDK w1 API v Plugin fifeanis fegudl 2.34

- S
Android SDK Manager

Packages Taols
SDK Path: C\Users\WEERACHAR AppData\LocalAndroid\andreid-studis'selk:

Packages
| i Name APl Rev. Status
| 4 [T Tacls|
[TJ " Android SDK Tools 2201 [ Installed
LJ,J‘ Android SDK Platferm-tools 17 [ Installed
]+ Android SDK Build-tools 17 7 Installed
| 4 Fu_ Android 4.2.2 (AP117)
[ [7] [ Documentation for Android SDK 17 2 |} Notinstolled
| SOK Platferm 17 2 [ Installed
Samples for SDK 17 1 7] Not instatled
| [{% ARM EABIv7a System Image 17 2 {or Installed
[Z] (i Intel xB6 Atom System Image 17 | Not installed
MIPS System tmage 17 1 [ Neotinstolled
i3t Google APls 17 2 | Not instolled
[717TT Sources for Android SBK 17 1. ["}Not installed

! o [T1C3 Android 4.1.2 (APL16)

Sortby: @ APllevel (3 Repositony Deselect &l [\ Defete packades..

Done loading packages.

JUA1 2,30 niliwhanis Update §2 SDK

2.3 35 Export lld APK uu Android Studio

Show: [¥]Updates/New [VlInstalled  [7] Obsolete Select [4ew: or Updatas Installipadtages I
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o o - a o =1 s v P T 2/ @
NAIINALRYULDUNGLATINATIUAD UAEWIBUNIL AU Google Play Store w09l

« a | Vo 1 o o a ¢ A
IWdupundiaduiniainnas Export iy Tneluaaunsadaliamanannniseeylndiite
npgauulvunule
#5729 Keystore

a o 5 b rA =l @ 1 5
Tun1s Export LLaU‘waLﬂ"ﬁ‘u‘lflﬂﬂﬂ‘iﬁ]umaﬂ‘ﬁl‘ﬂﬁmiﬂﬂﬂu?’i Keystore lagdiunaunis

Benluf Build > Generate Signed APK... ﬁqgﬂﬁ 2.35

Refactor m Run Tecls .V.Cﬁ ‘ﬁmdow !:‘{.éip

& o F Make Project Ci-F3 £
Make Module 'Tracking' Ctel+ Shift-F9
3 0" ;:: Rebuild Project > 3
e Clean Project =

- Generate Signed APK...
Deploy Module to App Engine... lize’
<item name="Acro >ACY(
<item name="Alt Hold":

5Ufl 2.35 19N Build uaz Signed APK...

Export uuavmﬂuauamaalu Keystore Hlsasluaaelulng ApK uu'] Favinlwsledn APK i
uuqmu‘uaa’[ﬂs Keystore Aa1usna31997n Android Studio 1mmmumaumu [3]
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2 . " X v I - o
22int1619 Generate Signed APK Wizard 4@mna2uin "l‘wﬂmju Create new... LWaN1N19
} 24 L A
a3 Keystore Aa3uv 2.36

s & 7 R’

¥ Generate Signed APK Wizard RS

Key store path: l C:/Users/Earth/workspace/Tracking/Tracking l

| __:C_reate new... | l Ch_ooseeiisti’ng.... ]

Key store password: | escoss

Key alias: l Tracking H

A __]
)
|

Key password: l sescee

(V) Remember password

' Previouk m Lquncde; ! Help

(I = - | 2 0w - v 2 v
w1919 New Key Store asianstuuifielulddoyadmiu Keystore azasransondeyaly
a Y v ' 9 <
Seufesudinadu OK degui 237

F{} New Key Store 4 . 'Lr' _ ; y D | )
Key store path: E C:.-'Users/Earth.fworkspachrackinngracking ]! _J ;
Password: l Cenfirm: [_ l .
Key I

Alias: l F ;
Pagsward: ! | Confirm: [ i

Validity (years): | 25[ ]

| Certificate

|
1 First and Last Name:

| Organizational Unit: l
{

E Organization:

i State or Province:

|

‘City or Locality: E
| I
|

';Countvy Code (XX)

g‘d‘ﬁ' 2.37 ¥1919 New Key Store
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YY) v v a = v vo v d v & v
sodninauntishameld Widag# Path AldAmualifasiiulng Keystore as1atuu i
Tdlnanananaiilunis Export ynass saguin 2.38

. Tracking 16/4/2558 16:19 File 3KE

gﬂﬁ 2.38 llawmas Key Store

=l

dm13Un135 Export IWa APK azfitunausiadl

\#enlUii Build > Generate Signed APK... ﬁqgﬂﬁl 2:39

r z : T 5N Frgh Ty
'# Generate Signed APK Wizard e o

Key store path: {C:{Userlearth/worhpaceﬂ' racking/Tracking ]

etenoe ) | Gommeonas

Key store password: | teoces : ]

Key alias: LTrécking H ;

Key password: I sessor ]

(V] Remember password

| Prevaetiy § m [ Cancel ,: ! Help :

1 i - e SPUSPNIRINES

U 2.39 %umaulﬂgjma Generate Signed APK...
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1Y A Lo v [ = v oa af =
Tinafilu Choose existing W&aidan Keystore fildaiandouly faguil 2.40 wasgud 2.41

e ‘ ] h

'#/ Generate Signed APK Wizard : =

MNote: Proguard settings are specified using the Project Structure Dialog

APK Destination Folder: | Jsers\Earth\workspace\Tracking\Android E E

Build Type: |release

Flavors: |

It praduct 1

Previous | | Concel ||~ Help |

gﬂﬁ 2.40 MR Generate Signed APK Wizard

: 0 ‘Tracking.‘
2 Tracking.iml
{1 usb serial for android master
71 Public
¢ [ Windows
[£] HaxLogs.bd

M. - 4

$U.2.41 wiwine Select Path

G‘S 1 o d o 12 b2 v 1
ntuAldsiaues Keystore, ¥ Key wassiauad Key WS uios udanatu Next
AIFUN 2.42



[ #! Generate Signed APK Wizard

Key store path: Ci/Users/Earth/workspace/Tracking/Tracking
Y P

| Create new.., |

Key store password: l seesee

Key alias: f Tracking ff i
Key password: [ essene —J
I_:Z] Remember password
[ Preigi] m | Cancel [\ Help |
' e B e e s NN
o o ; "
JUN 2.42 »ueN Generate Signed APK Wizard
4 1 o G‘ ar 2 al =
wihsesnadunisimusieaiulilg APK degui 2.43
11 7 M
(%) Generate Signed APK Wizard N =)
J Note: Proguard settings are specified using the Project Structure Dialog
APK Destination Folder: | Jsers\Earth\workspace\ Tracking\Android || !
Build Type: ' release e ¢
Flavors:
& sqf
| Previous 5 fjmsh I Cancel { f Help ]
M S o4

gﬂﬁ 2.43 wi#19 Generate Signed APK Wizard

. . = o w ¢ ay v
APK Destination Folder - \ian Path dwsuinulud APK #ilé
Build Type - @ansuiuunis Export

U
a e =1 @ v I s vy
e muaaiawalvinaUu Finish
solusunsuinig Export 1@3e feeiiviseudeduan dguil 2.44

22
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-

( ¥ Generate signed APK LB

) @ Signed APK's generated successfully.

| i e

ke Py,

g‘lJ“ﬁl 2.44 WA Generate Signed APK

. A A L ¢ v ' e o
818N Show in Explorer iailantisineglng APK Aliniaaznadu Close Wallnndisad
6]

-1 ¢ o ~ v o
wWieavilnazlalng APK Tinfanaziondiu Google Play Store ud Aagu 2.45

hame Date medified Type Size
1. art 8142558 0:07 Fife folder
. build L14/472558 206 Fite falder
L. libs 8/4/2558 4 File folder
fis res J/4/255823:59 Fiie folder
J srC TA2558 23159 il folder
| DS_Store A58 04 DS STORE File TKB
| «gitignore 274372558 8:52 GITIGNORE File 1¥B
__ Android.iml 1G/4/2558 15:57 IMEFilz 8 KE
2 AndroidManifest.xml 16/4/2558 161 FRgcument 6 KB
__| build.gradle 27422558 5:52 GRABLE File 4KB
L= lintxml 21372558 8:52 #MilDocurgent 1KB
., manifest-merger-release-report.txt 16¢4/2558 1643 Text Document 12KB
__| proguard.cfg 27/37/2553°8:52 CFGFRile 3KB
__. project.properties 24312558 §i32 PROBERTIES File 1KB
| tower-release.30105.apk 17/4/2558 7:30 APKFile 4,296 KB

SUT 2.45 wiiving awaed 7l save Told apk
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2.4 Google Maps Android API v2

dM9$U Google Maps API v2 qxilnsasuudasiuan Google Maps API v1 Wil
wneldifuet agratu mve AP Key fisisasing Google APl #ae nsiFenld Google Maps
funnsnsluannuesiulgl

2.4.1 n13v8 APl Key 911 Google

Lﬁaa%’ma%mt.é’?ﬁwa API Key Ingaasaiaslte Cloud Console ii Google Cloud
Console e Log In 1w udafisswufiuniusnues Cloud Console nAYu Create Project
Weviinisad Project Aoulpewdle https://console.developers.google.com/project
Flaguit 2.46

GU‘. ‘glc Cloud (€pgcle Sign out

Projects
Billirg
Account settings
You donthave any projects!

Create a ns\v project (o iget stared,

'g‘tJﬁl 2.46 N385 Project tu-Google Cloud Control

2 o
= af

NUUlARITD Project muariivesliiimun Project ID Tnefivesilazdiamisoliszuuaen

= W 3 ] o o 5
Project ID TWAlS 9 nTududunaes | have read and agree to all Terms of Service......
LNy Create 1iayin1sass Project Tuan




] vy e : A ) ar =
ntufzdhgmin Overview Mluniusnaalu Cloud Console feguil 2.47

Froject ID: copper-sunspot-31706 Froject Number: 931244499116

Project Dashboard

Take the Google App Engine quickstart
Lea
to the cloud. Dusation; ~10min

“Take the guickstart

Try BigQuery with population data

Run quetis dgainst hugepublic datalsets i1agezhow
<) ge P
£ your ovan date

BigQuety cin help you anall

375 00

rn ‘Hello World” for App Engine and deplo

Take the Compute Engine quickstart
| MongoD8 en Com

Use Node

Create a storage bucket
StoreyOur uasitutluied data sdfglyand with high a2
MingGoagle Clapd Storage

Create bucket

gﬂﬁl 2.47 %1 Overview 984 Cloud Console

d 1 £ (4 A v A A .
naawnuteilelinadonil APIs uANGoUAINIRoY ¢ NB91T Goosle Maps Android

APl udnmiial Enable fegudl 2.48

Popular APIs

Google Cloud APls
Complie Bfgine AP

Advertising APls
LB Anagement kit

Google Maps APIs
Gaggls Maps ARd:id AR
i O < Sl for 0

Social APls
8+ Google+ AFI

Cther popular APls
Transiate API

3U# 2.48 with APls 184 Cloud Console

25
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o - t Y 1A 2 s ] v d o a 2 T (Y v
Walnadaudrasiiuinlaldnuuds drusudundalisguarbidesaulanle du
a < 4 & &z - % Y <
UIN150U9U9 Google Fananualuililu APl 910 Google Nanunsaveldaulamiuesiuny
1 2 £y . = i ¢ 4 o i
dosteilelvinaidien Credentials fiogsoan APIs Fulunisamzilou Application eve
v v oal 9 -
14 APl w84 Google lvinafilu Create New Key flagufl 2.49

DAuth Neo client 1Dz found

QAuth 2.0 af

with you |

heeping their
ather information private

No keys found

‘gﬂﬁ 2.49 i Credentials ¥94 Cloud Console

& AL W s X YR 1 o o as w . 9] =
Mnduasiinidstuunliidendiazaing Key divivesls Aliiden Android Key Aagui

2.50

i LUMMIPERE RGN @it App cuyie L edii e

{ Create a new key

The APIs represented in the Google APls Console require that
requests include a unique project identifier. This enables the Console
1o to tie a request to a specific project in order to menitor traffic, enforce
vl quotas, and handle billing.

Server key Browser key Android key 108 key

ic APT'access
JUN 2.50 mihsinsdwiuidenuiin Key

yedimiigbidmuna TnedisldSHALPackageName dm¥u SHAL aunsaudald
. " 5 al =3 & 1
9N Certificate Fingerprint 97nWd debug.keystore Maglunauiaimosuaausiazay
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2.4.2 Jundun1si¥a Certificate Fingerprint
ada 2/ | i £ e . . g al
ningomisasnou nsizazaeald Certificate Fingerprint @1v37Un1399
o % W v v ow 2 . .
APl Key \olwanunsalde1u Google Maps APl v2 Ia lianlun C:\Program Files\Java\jre7
1ag jre7 usgiuin flias Java il fasilwuildnamesidug ndunlinadu Shift
17 v o a o ¢ . @ i . 2/ .
Aald wdardnaivialnes bin waden?l Open command windows here (fa4na Shift
= o <l
flaauiii) dagud 2.51

B2 | jre? - o ks
m Home Share WViews v 0
| ‘L(fi :} - P v Computer » Local Disk (G} » Program Files » Java » 3re.*'_"v ~ O Search jre! pe

A . '— Open 1 3 y
¢ Favourites Nargl o ded i e
" w & 4 Open in new process [ AR, . IO
BT Deskiop i h-q__ i Open in Fewonindod it PILH‘ F Je i older .
{ owhioads § ? B PIA le folde
. Download i hb i\ Pinto Start o Pl File folde
My Program | COPYR BB : B ¥ila 2K8
. Local Disk (D) | LICEMS] ,, Y i F.-Pt.f KE
| = ( e | Browse in Adobe Bridge CS6 i sy .
| ] READN;fomst e AT Beutr et U RLS Igalocumeant 1KE
| . | Qpen cammand window here . 3 "
| s Libraries = releasei — A T o Pt Kl | KE
1
| | Documents | THIRDE - Share wath b PR | T 184 Decument 174 KE
‘-‘5- Music \ 4 THrEQZ Include in library FOXAPR Text Dochmant T¢3 KE
I Pictures ;;\‘.‘elccd;}\ Ualocke? Lo P ST Fie * KE
B$ videos |
i Send to »
+§ Homegroup l Cut
| Copy
1 Computer |
= i Create sherteut
e Local Disk (C)
F ) 1 A4 Delete
o Local Disk (D) ¥
| |
| Local Disk (E) | mtien=ig
! i, Galaxy Nexus | Praperties
v b e
| Qitems 1 item selected Efl =
Ty - e e T 1. et AR . * ¢ o

5U#1 2.51 msiTa Command Line Tu Folder Aisatnns

d1¥U Windows Vista, 7, 8 liay 8.1 Wifuwiedanasit
keytool -list -v -keystore "C:\Users\user_name\.android\debug.keystore" -alias
androiddebugkey -storepass android -keypass android -v

¢ P! P ¢ 4 W |
lng user_name Aolwainoiuos User Account #ldlunauiames Audladedina1n
Wiasetuiniasvesdldfeddunmsiedrsdnean iWweasudenldiedn iloaviriifagle
< i . -l o v ow =i
Certificate Fingerprint 1Mis8UToBUAY ANFUN 2.52
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Administrator: C\Windows\system32\cmd.exe

Certificatell]:
Ouner: CN=Android Debug. O=Android, C=US
Issuer: CN=Android Debug. O=Android. C=US
erial nunher: 58708137
alid from: Thu Febh 26 11:21:089 ICT 2815 until: Sat Feb 18 11:21:89 ICT 2845
Certificate fingerprints:
MD5: 9A:94:4B:E9:96:D6:3F:2E:BB2808:61:4A:62:CC:47:8B
SHAL: CC:15:A7:AF:65:0BC:FC:A5:7B:A8:ED:67-80 BFE:84:48:8E:9F
SHA256: C6:71:EE=25:C4:58:A9:01:AA:CB=89:F3:E4:6A:A7:42:ED296:8D:C3:08:
D?:4C:BE:51:E?:7D:C4:72:69:83:00
Signature algorithm name: SHA256uithRSA
Uersion: 3

Extensions:

f#1: Objectld: 2.5.2%.14 Criticality=false

uhjectKeyldentifier [

Keyldentifier [

20ua: B6 2B 31 C8 AE 55 C6 36  DC 14 .F5 F1 DEF E? 85 CB - .+1..U.6.
?319: 38 BA 95 FA ‘ 8...

[C:\Progran Files\Java\jre?\bhind

FiEemns - TRem sevected

g'ﬂﬁ 2.52 wiiwre Command Line taldlunismaa Fingerprint SHA1

= . : & v v L s =
\Waldn Certificate Fingerprint wazlailu SHAL uSeusesudas nduun Cloud
L7 1 ] A E @ A v I E 2 é"

Console und Wild SHAL flnasly muddeinSoanuie ; ud6en 1890 Package Vo4
; 5 o v v | el . ’ "
Application f83n1514994U Google Maps axisiuindaos Key for Android applications

' Pl 2l o bS A v & v w =
wanaog Jldvmiasiiudil Key fasauaniluanuas fagun-2.53

Key for Android applications

APl key AlzaSyAPWGUB0ImPPIOKIJwidReATOGoZeMOTRgs

Android applications CC:H5 A7 AF65.0CFC:AS7B.ABED67:80:42:3B:BF §4'd8-8E:9F org.droidplanner.android
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1. Arduino MEGA 2560
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ARDUINO

- : \ - "'Product Overview

The Arduino Mega 2560 is a microcontroller board based on the ATmega2560
(datasheet). It has 54 digital input/output pins (of which 14 can be used as PWM outputs),
16 analog inputs, 4 UARTs (hardware serial ports), a 16 MHz crystal oscillator, a USB
connection, a power jack, an ICSP header, and a reset button. It contains everything
needed to support the microcontroller; simply connect it to a computer with a USB cable or
power it with a AC-to-DC adapter or battery to get started. The Mega is compatible with
most shields designed for the Arduino Duemilanove or Diecimila.

Technical

‘Specifications Page 2
PR Page 6
] Page 7
Epon nietpolcEs Page 7
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Technical Specification S

EAGLE files: _arduino-mega2560-reference-design.zip_Schematic: arduino-mega2560-schematic.pdf

Summar
Microcontroller ATmega2560
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital /0O Pins 54 (of which 14 provide PWM output)
Analog Input Pins 16
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA
Flash Memory 256 KB of which 8 KB used by bootloader
SRAM 8 KB
EEPROM 4 KB
Clock Speed 16 MHz

the board

Power
Led
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The Arduino Mega2560 can be powered via the USB connection or with an external power supply. The power source is
selected automalically. External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or baltery. The
adapter can be connected by plugging a 2.1mm center-posilive plug into the board's power jack. Leads from a battery
can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may
supply less than five volls and the board may be unstable. If using more than 12V, the vollage regulalor may overheat
and damage the board. The recommended range is 7 to 12 volts.

The Mega2560 differs from all preceding boards in that it does not use the FTDI USB-to-serial driver chip. Instead, it
features the Atmega8U2 programmed as a USB-lo-serial converler.

The power pins are as follows:

@ VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 5 volts
from the USB connection or other regulated power source). Yau can supply voltage through this pin, or, if
supplying voltage via the power jack, access it through this pin.

o 5V, The regulated power supply used to power the microcontroller and other components on the board. This
can come either from VIN via an on-board regulator, or be supplied by USB or another regulated 5V supply.

o 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.,

@ GND. Ground pins.

The ATmega2560 has 256 KB of flash memory for storing code (of which 8 KB is used for the bootloader), 8 KB of
SRAM and 4 KB of EEPROM (which can be read and written with the EEPROM library).

Each of the 54 digital pins on the Mega can be used as an input or output, using pinMode(), digitalWrite(), and
digilalRead() functions. They operate at 5 volls. Each pin can provide or receive a maximum of 40 mA and has an
internal pull-up resistor (disconnected by defaull) of 20-50 kOhms. In addition, some pins have specialized functions:

@ Serial: 0 (RX) and 1 (TX); Serial 1: 19 (RX) and 18 (TX); Serial 2: 17 (RX) and 18 (TX); Serial 3: 15 (RX) and
14 (TX). Used lo receive (RX) and transmit (TX) TTL serial data. Pins 0 and 1 are also connected to the
corresponding pins of the ATmega8U2 USB-to-TTL Serial chip .

oo External Interrupts: 2 (interrupt 0), 3 (interrupt 1), 18 (interrupt 5), 19 (interrupt 4), 20 (interrupt 3), and 21
(interrupt 2). These pins can be configured to trigger an interrupt on a low value, a rising or falling edge, or a
change in value. See the attachinterrupt() function for details.

«  PWM: 0 to 13. Provide 8-bit PWM output with the analogWrite() function.

w0 SPl: 50 (MISO), 51 (MOSI), 52 (SCK), 53 (SS). These pins support SPl communication, which, although
provided by the underlying hardware, is not currently included in the Arduino language. The SPI pins are also
broken out on the ICSP header, which is physically compatible with the Duemilanove and Diecimila.

@ LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is on, when
the pin is LOW, it's off,

@ I’C: 20 (SDA} and 21 (SCL). Support I*C (TWI) communication using the Wire library (documentation on the
Wiring website). Note that these pins are not in the same location as the I°C pins on the Duemilanove.

The Mega2560 has 16 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By defaull
they measure from ground to 5 volts, though is it possible to change the upper end of their range using the AREF pin and
analogReference() function.

There are a couple of other pins on the board:

« AREF. Reference voltage for the analog inputs. Used with analogReferenca().

*  Reset. Bring this line LOW fo reset the microcontroller. Typically used to add a reset button fo shields which
block the one on the board.

| REOIDSDERES RADICMICS “A

ALKED ELECTR

SR A

61



Communication

The Arduino Mega2560 has a number of facilities for communicating with a computer, another Arduino, or
other microcontrollers. The ATmega2560 provides four hardware UARTSs for TTL (5V) serial communication.
An ATmega8U2 on the board channels one of these over USB and provides a virtual com port to software on
the computer (Windows machines will need a .inf file, but 0SX and Linux machines will recognize the board
as a COM port automatically. The Arduino software includes a serial monitor which allows simple textual
data to be sent to and from the board. The RX and TX LEDs on the baard will flash when data is being
transmitted via the ATmegaB8U2 chip and USB connection to the computer (but not for serial communication
on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Mega's digital pins.

The ATmega2560 also supports 12C (TWI) and SPI communication. The Arduino software includes a Wire
library to simplify use of the 12C bus; see the { n.t iring website for details. To use the SPI
communication, please see the ATmega2560 datasheet.

The Arduino Mega2560 can be programmed with the Arduino software (download). For details, see the
reference and (utarials.

The Atmega2560 on the Arduino Mega comes preburned with a bootloader that allows you to upload new
code to it without the use of an external hardware programmer. It communicates using the original STK500
protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuil Serial
Programming) header; see these instructions for details.
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: Automatic (Software) Reset

Rather then requiring a physical press of the reset button before an upload, the Arduino Mega2560 is
designed in a way that allows it to be reset by software running on a connected computer. One of the
hardware flow control lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega2560 via a
100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long encugh to reset the
chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload
button in the Arduino environment. This means that the bootloader can have a shorter timeout, as the
lowering of DTR can be well-coordinated with the start of the upload.

This setup has other implications. When the Mega2660 is connected to either a computer running Mac OS X
or Linux, it resets each time a connection is made to it from software (via USB). For the following half-second
or so, the bootloader is running on the Mega2560. While it is programmed to ignore malformed data (i.e.
anything besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives ane-time configuration or other data when it
first starts, make sure that the software with which it communicates waits a second after opening the
connection and before sending this data.

The Mega contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

8 USB Overcurrent: Protection

The Arduino Mega has a resettable polyfuse that protects your computer's USB ports from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics and Shield Compatibilit

The maximum length and width of the Mega PCB are 4 and 2.1 inches respectively, with the USB connector
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.18"), nat an even multiple
of the 100 mil spacing of the other pins.

The Mega is designed to be compatible with most shields designed for the Diecimila or Duemilanove. Digital
pins 0 to 13 (and the adjacent AREF and GND pins), analog inputs O to 5, the power header, and ICSP
header are all in equivalent locations. Further the main UART (serial port) is located on the same pins (0 and
1), as are external interrupts 0 and 1 (pins 2 and 3 respectively). SPI is available through the ICSP header on
both the Mega and Duemilanove / Diecimila. Please note that I’C is not located on the same pins on the
Mega (20 and 21) as the Duemilanove / Diecimila (analog inputs 4 and 5).
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wiring) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
0S. Check on the Arduino site for the latest instructions. http:/arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

: Blink led

Now you're actually ready to "burn” your
first program on the arduino board. To
select "blink led”, the physical translation

B bunk | arduinoois
Fle Fdb. Sketch Tools Help

5) (03] (2] [ 8l i)

of the well known programming “hello
world”, select

int ledPin = 13: 4 LED comected to digital pin 13

47, Tie etup | ) wethed Buns whee,| vhen thi skELohoorablts

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

M veidd setam () {

Arnitialize che digical pin gx ap ongpur;

pinMede(ledPin, QUTPUT): |
¥ |

Once you have your skecth ygu’" A the 1bop() metod sdus over S OWEE uyuin, |

. 440 a3 lonyg 43 the Arduing hay powsr {
see something very close to the _ '
screenshot on the right. \§ Y

digicalisitc (ledPin, HICH)y '/ oot the LED, on
dmlay (1000) & i L fudea ooy il
dagria lupine(ledPin,  LUW) ; :
delay (1000) ¢

In Tools>Board select MEGA

Now you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to.

Done compiling. :l.d

Press Compile button

{to check: for errors) Upload

TX RX Flashing

Ao
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Terms & Conditions

1. Warranties

1.1 The producer warrants that its producls will conform to the Specificalions. This warranty lasts for one (1) years from the date of the sale. The
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,
ar for any products that have been altered or medified In any way by a Customer. Moreover, The producer shall not be liable for any defects that resull from
Cuslomer's design, spacifications or instructions for such products. Tasting and other qualily control techniquas are used o the extent the producer deems
necessary.

1.2 Ifany products fail to conform to the warranly sel forth above, the producer’s sole liability shall be 1o replace such producis. The producer’s liability
shall be limited lo products that are determined by the producer not to conform to such warranty. If the preducer elects lo replace such products, the
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3 EXCEPT AS SET FORTH ABOVE. PRODUCTS ARE PROVIDED "AS IS* AND "WITH ALL FAULTS.” THE PRODUCER DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TQ, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4  Cuslomer agrees that prior lo using any systems thal include the producer products, Customar will test such systems and the functionalily of the
products as used in such systems. The producer may provide technical, applications or design advice, quality characlerization, reliability dala or other
services, Cuslomer acknowledges and agrees that praviding these services shall not expand or otherwise alter the producer’s warranties, as sel forth
above, and no additional obligations or liabilities shall arise from (he producer providing such services.

1.5 The Arduino™ products are not authorized for use in safaly-crilical applications where a failure of the product would reasonably be expecled to cause
severe personal injury or death. Safety-Crilical Applications include, without limitation, life support devices and systems, equipmaent or systems for the
oparation of nuclear facilities and weapons systems, Arduino™ producls are neither designad nor inlended for use in military or aerospace applications or
environments and for automotive applications or anviranment, Customer acknowledges and agrees that any such use of Arduino ™ products which is solely
at the Customer’s risk, and that Customer s solely responsible for cempliance with all legal and regulatory requiremants in connection with such use.

1.6 Customer acknowledges and agraes that iLis salely responsible for compliance with all legal, regulatory and safety-related requirements concerning its
products and any use of Arduino™ products in Customer's applicalions, notwithstanding any applications-related information or support that may be
provided by the producer.

W Indemnification

The Cuslomer acknowledges and agrees to defend, indemnily and hold harmless the praducer from and against any and all third-party losses, damages,
liabililies and expenses il incurs to the extent direclly caused by: (i} an actual breach by a Customer of the representation and warranties made under this
lerms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3 Consequential Damages Waiver

In no evenl the producer shall be liable to the Customer or any third partias for any special, collateral, indirect, punilive, incidental, consequential or
examplary damages in connection with or arising out of the products provided hereunder, regardless of whather the producer has baen advised of the
possibility of such damages. This section will survive the terminalion of the warranty period,

4. Changes to specifications

The producer may make changes lo specifications and product descriptions at any time, without natice. The Customer must not rely on the absence or
characlerislics of any features or instructions marked “reserved” or "undefined." The producer reserves these for future definition and shall have no
responsibility whalsoever for conflicts or incompatibilities arising from future changes to them. The preduct information on the Web Site or Materials is
subjact to change without nolice. Do nol finalize a design with this information.

Enviromental Policies

The producer of Arduino™ has joined the Impatto Zero®
policy of LifeGate.it. For each Arduino board produced is
created / looked after half squared Km of Costa Rica's
forest's.

[
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2. GPS NEO-TM

NEO-7 series

u-blox 7 GNSS modules

Highlights

* GNSS engine for GPS/QZSS, GLONASS

« Praduct variants to meet performance and cost requirements
* Combines low power consumption and high'sensitivity

* Backward compatible with NEQ-G'and NEO-5 families.

Product description

The NEO-7 series of Standalone GNSS modules s Cuit on

the exceptional performante @i the usblox 7 GNSS (GRS,
GLONASS, QZ55 and SEAS) engine The NEO-7 series delvers
high sensitivity and mipimal.acqUisition tanes in the induslry
proven NEO form factor.

The NEQ-7 series provides-maximum sensifivily while maintain-
ing low system power, The NEO-70 is optimized for cost Sen-
sitive applications, while NEQ-7N provides bést performance
and easier RF integration. The industry prover) NEQ form factor
allows easy migration from pravious NEO generéuens: Sophis-
ticated RF-architecture and interference supprassion ensure
maximum performance aven I GPS-hostile gnvironments

The NEO-7 combines a high leveloi robustiess and inte-
gration capability with flexible conhectivity options. Future-

Product selector
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NEO=F series:
12.2%16.0 x 2.4 mm

praot the NEQ-7N'Sinternat Plash allows simple firmware
upgrades for supporting additional GNSS systems. This makes
NEO-7 perfectly suned tondustrial and automative applica-
tiohs’ The\DDT (1L compliant)interfaceprovides conne@ctivity
and enables synergies with u-blax cellular modules. For RF
aptimizaton the NEQ-ZN-featuies an additonal front-end LA
for easier antenna inteqgration and a_frontsend-SAW filter for
Increased jamming immunity.

u-biox ¥ modules use GNSS ehips-gualified acearding to
ALC-Q100 30d ate manufactiradan 1SG/TS 16943 certifiad
sites. Qualification tests are perfarmed as stipulated in the
BO16750 standard:“Road vehicles — Environtental cond-
lions and testing for electrical and electronie equipment”
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Features Package

5&-channel u-blox 7 engine 24 pin LCC (Leadless Chip Carer): 12.2 x 16.0x 2.4 mm, 1.6 g
GPS LT C/A, GLONASS LT FRIVIA,
QISS LT C/A Pingut

SBAS: WAAS, EGNOS, MSAS

Racawver type

GNo GaMe
Navigation update rate up to 10 Mz ANT_QURneivil BN
Reserved LN
GPS GLONASS Rasersind vee we
Accuracy Position 25mCEP 4m Resarved KESET I
SBAS 20mCEP na |
na NEO-7 wOD Ush
Acquisition Cold starts 295 305 q s TOPVIEW g e
Ardled starts: 5s na. B use o
Reacquisition 1% 3s [ EXTINT
¥ sckr TIMEPULYE i
Sensitivity Tracking & Nav: ~162 dBm 158 dBm vee BsiL |
Cold starts: -148 dBm =139 dBm oD Aushived |
Warm starts ~148 dBm 145 dBm

AssistNow Onling

AssistNow Offline
Assisthow Alftgrormous Environmental data, quality & reliability
OMA SURL &BGPP complant

Assitance GPS

=407 Gla85 C

Osciliator
RTC crystal
Moise figure

Anti jamming

Memary
Supported antennas

Electrical data

TCXOMNEQ-7N), crystaltNEOTI)
Bunlt-ln

On-chip LNA (NEC-7M); Extra LNA for
lowsest noise figure INEQ-TN}

Atlve CW detecthoniand removal, Exira
onbogrd SAW Band pass filter (NEQ-7M)

ROM INEQ-7M) or Flask (NEQ<T )
Actweand passive

Qperating temp.
=04 1o 85° C
RaHS comphant tsad-frée)

Storage 1emp:

Qualification accorcng 1S 16750

Manufactured.in ISOAS 16949 cortified production sites
Uses u-blox 7 chips qualified according fo AEC-Q100

Support products

Suppiyvoliage

Power Consumption

1.65 ' .to 3.6 V (NEG=7M)
27 Vo3 eNANED- TNY

17 mAD 3V (Cortinunus)
5 A @3 Power Savetigde (W)

t-blow 7 Evaluation Kits:

Easy-to-use kitsto got familiar with ai=blox 7 positioning technology,
evaluate functiopality, andwisialize GNSS perfarmance

EVE-7N u-blox 7 GNSS Evaluation Kit,
sunpOENESTR
Backup Supgly 18V 364 with TEXO, suppors NEC-ZH
NEG-TH EVR-7C; U-blox 7 GNSS Evaliation Kit,
with Crystal, sunports NEQ-7M
Interfaces Product variants

Serial interfaces

Digital VO

Timepulse

Protocols

Lugol Hotice

Uk

JBK-13003242 - ROG

1 UART

1 USBY2 0 full speed 12 pMbing,

1 SPI {optional

1 D0C (FC compliant)

Configurable imepulse

1 EXTINT input for Wakeup
Confiqurable  0.25 Hz 1o 10 MHz

NMEA, UBX binary, RTCM

NEC-7H
SAW, LNA
NEQ-7M

Further information

u=plox Z6NSS LCC Module, TCXO, Flash,

u-blox 7 GNSS LCC Module, Crystal, ROM

For contact information, see www.u-blox.cam/contact-us.
For more product details and ordening information, see the

product data sheet,

wwaw.u-blox.com



3. 3DR Telemetry 915 MHz

3CRobotics

3DR RADIOV?
QUICK START GUIDE

GETTING, STARTED

3DR Radias provide an air-to“grourd data link betweenthe autopilotand yourgrow'd station laptop or
tablet. Follaw thisglide to insiallthe radios onyaur planescopter, or rover, 3DR Radios arrivérgady to
use. Just mount and cennect teviewreal time datafrom your drone.

ALTC
Pf“\ 1D

Two 3DR Radios in, 815war 433 mMz

Attach the antenngs, and use cither@dio as an girerground module

S

Android adapter cable Micro-USB cable

o, Dwire Pixhawk connector cable

6 ta-5- position APM and PX4 connector cable
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CONNECT TO AUTOPILOT

Connect to the APM 2.5 or 2.6 telemetry port using
tha &-to-5-position cable

Connect to the PX4VO telemetry

Gonnect tothe Pixhawk telemetry
port using tha®-10-5-position.cable

port bsing the 8 wire

MOUNT

Maourtt the air modulasecurely W your vehicle koeping the antenna glear of any propeliargor moving
components. Ensure that the antenna iserented vartically for maximum range.

CONNECT TOMISSION-PEANNER

Migsion Pranmar

Use the micro-USB cable to connect the ground module to your laptop. In Mission Planner and APM
Planner ground stetion applications, selsct the communication option that shows COM. set the rate
to 57600. and select Connect. The radic will not connect unless the vehicle is powered. Use the Flight
Data screen to view your vehicle's status and control missions in flight.

LEARN MORE

about installing a mission plannier application for your laptop or tablet and interacting with the
autopilot using 3DR Radios (including retrieving flight data logs) at planner.ardupliotcom.



View the strength of the radio signal in the
mission planner's Hlight data screen.

TIPS

Orlent the ground radio

antenna vertically for
maximum range.

Connect the ground module to your tabiet using the Android adapter cable. Connect the colored end
to the tablet and the black end torthe radio. In DroidPlaniner or Andropilot, seldet Connect.

{ connect

CLEARWPS

L NG 3 At
DraidPlarier Flight Data screen

SETTINGS

To change the radio settingsin the mission planner. connact the radio toyour computer, but do not
select Gonnetl. Radios can only be configured while urconnested to MAYLInk Select Initial Setup;
3DR Radio, and-Load Settings ta configura the radios:

Stotus Locks

e e el L L L R N TR . .
Vorssort . SHLE O MM TRP. FREQLO1S S 16 on HMHTRE

LRRSSE 174182 /R noise 43739 pids 1523 a0
RSSL xee0 stiel) 300 e~ iemp276 ceo-0

Bl = Min Freq

Bond R - |
o] o

:H:I!D_ ] s BN
TR Powar

ECC

Mendink

Op Resand

All sattings should be the same for both modules. Ensure that the Net ID
radio to enable pairing. Select Save Settings to apply settings. For flying with friends, mal

Nat IDs dao not conflict

Mt Fraq Baud

Channels A Syt

Dty Cycle Pt 1

LBT Rssi Tx Pt

Noda ID

Noda Dast Mavink

Hoda Count Op Resend

hhin Freq

Mo Froq

# of Channels J .
DutyCycle

LEBT Rest

ing is identical on sach
& sure your

Use the configuration options on this screen to apply the correct airspace regulation raquiremeants

for your arsa. You are responsible for complying with all airspace regulations in your area, including
frequency restrictions, power levels, and licenses. For more infarmation on configuring 3DR Radios to

comply with local regulations, visit the online documentation

tgoo.ghTsrksf
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LED MEANINGS

eﬁ Blinking green ‘, Blinking red
) Searching for palred radio M/ Transmitting data
@', Solid gresn i Solid red
5 Link established with paired radio R Firmware update mode

RADIO DESCRIPTION

-

|
1
2
]
1 Micro-USB port
2 G-wire cablg cennectar 5
3 Antanna
4 Frequency
5 LED indicator
SPECIFICATIONS
Processing Foatures
100 mW maximum output powasr (edjustable) interchangaable airandground modules
117 dBm receiveSensitivity 815 or 433 iHz
Basad on HopeRF's HM-TRP modile Micro USE port
RP-SMA connastor Beposition.DF13 connestor
2-way full-duplex comimunication through adaptive TDM
UART interface Dimansions
Transparent serallink 287 €555 gm x 13.3 cm
MAVLIink protocol ;‘raming (without antenna)

Frequency Hopping Spread Spectmim (FHSS)
Configurable duty cycle

Emor correction corrects up to 25% ofbit errors
Open-source SIK firmware

Configurable through Misslon Planner & APM Planfgr

Power

Supply voltage: 3. 7.6VDGHfom USB or DF13)
Transmitewrent; 100°mA zt 30 dBm
Receivercurrent. 25 mA

Seral interface: 3.3V UART

Q b) i

SUPPORT

For more Information about mission planner applications and APM firmware, visit ardupilot.com. For
online dosumentation of 3DR Radios, visit goo.gh Tsrksf

For custamer support, contact us at help®3drobotics.com or call our support line at +1 (858) 225-1414

3DR Radis Guids V1 © 30 Robotics, Ine. 28 Cctober 2015





